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Welcomel!

Thanks for choosing AT&T WOoRLDNET Service — an exciting
new world of opportunity, fun, and excitement.

Brought to you by the global leader in communications and net-
working, AT&T WoRrLDNET™ Service delivers everything you need
to make the most of the wealth of experiences you can find on the
World Wide Web. Just follow the simple instructions in this booklet,
and soon you'll be exploring the Internet as a registered AT&T
WoRLDNET®™ Service member.

About your computer system

Make sure your system meets these minimum requirements:

« IBM compatible 386SX computer (486 recommended)
« 8 mB of RAM (or more for better performance)

e 11 e of available hard disk space

« VGA card and monitor capable of displaying 256 colors
e 14,400 bps modem connected to an outside phone line
¢ Microsoft® Windows 95

;ﬂ Windows 95 note: If Dial-Up Networking is not installed, have
" your Windows 95 cp-rom or disks handy (see page 32).



About AT&T WorldNets™ Service

To register, you must provide the following information:
= Your registration code (printed on the address label)

e Your credit card number (MasterCard®, ViIsa®, or
American Express®card; charges will appear monthly on
your statement)

e An E-mail ID and password of your choice (so you can
send and receive electronic mail)

e A security word of your choice (to verify your identity if
you update your account information)

During registration, you must select a pricing plan. Hourly and unlimit-
ed usage access options are available. After you become a member, you
may change your pricing plan by updating your account online, send-
ing an electronic mail message to

wnetbill@attmail.com, or contacting AT&T Customer Care at

1 800 400-1447.

Finally, you must select an access telephone number (the number
your modem dials for access to AT&T WOoRLDNET*™ SERVICE). For a
complete list of numbers, see page 24.



Installing the AT&T WorldNet™" Service software

First, make sure your modem is ready to go — that is, it should be
turned on (if external) and configured for Windows 95. Make sure
Windows 95 is running, and close all open applications and folders, includ-
ing Dial-Up Networking, on the desktop and taskbar.

cD rRoM installation: Insert your AT& T WORLDNET™ SERVICE CD-
rRom disk. Software installation will begin automatically.

Floppy disk installation: Insert the AT&T WOoORLDNET™ SERVICE
software (Disk 1 of 3) in your drive. Click the Start button on the
Windows 95 desktop (see next page). Click Run, then type a:\setup
(or change the “a” to a different letter if the software is in another
drive). Click OK to begin software installation.

If Dial-Up Networking is not installed, you will be asked if you want
to install it. We recommend that you install it now. To install it later,
see page 32.

If you need assistance during installation, see the If You Need More
Help section beginning on page 30 for solutions to problems like
these:

e If Windows 95 is not configured for your modem, see page 30.

« If Netscape Navigator 2.0 software is already installed on your
computer, see page 35.
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] Type the name of a program, folder. or document, and
3 YWindows will open it foryou.
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If you're already an AT&T WORLDNET®™ SERVICE member:

If you're upgrading from an earlier version of AT& T WORLDNET™
SERVICE software, do not install the new software in the same folder.
Use the default instead (c:\Program Files\WorldNet).

After you run Setup, see page 36 for instructions on how to complete
your upgrade quickly.



Setting up your account

After the software is installed, several icons are displayed in your new
folder. To set up your account, double click the account setup icon as
shown below. If you see the message “You must log on to your PC
before registering,” see page 34.

Double-click this icon to begin.
When the first Account Setup
screen appears, click Next to
continue.

& {needio create an ATAT 'WorldMet Service account)
 |already have an ATAT Waorldhet Service account

Help < EEEE I MNext > | Cancel

At the second screen, select the “create account”
option, then click the Next button to continue.

=
=5
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To set up your account you must answer a series of questions about
you, your credit card preference, your modem type, and your phone.

At the “Modem Information” screen, click Next if a modem name is
displayed in the box. If the box is empty, or if the wrong modem is
displayed, please turn to page 30 for help.



Fill in the blanks on each screen,
then click the Next button to contin-
ue as you complete each screen.

:.) Account Setup Wizard

MNarp (Bysiness accounts: Mame of designated user)

[
Mame of Business (Required for business accounts):

Address 1 (Street):

Address & (P.0. Box. Room, Apt. Number):

|
City: State: Zip:

< Back hext > Cancel |
\/\;

Click Next after you complete each page. Click Finish on the last
page to transmit your member information to AT&T using a private,
toll-free number. Your information is kept strictly confidential.




Completing your registration

The last step in registration is to review and complete the informa-
tion you entered while setting up your account. If the system finds
an error, the screen is redisplayed with a STOP sign to show where
you must enter the correct information.

Registration Code Information

Enter your registration code as printed on the top of the address label

on your AT&T WorldNet™" Service Kit. If you do not have a registration
code, please call the AT&T Customer Care Center on 1 800 400-1447.

Registration Code:

Enter the 9-character registration code printed
on the address label of your AT&T
WOoRLDNETS" SERVICE Software package

During registration you must choose an Account Information securi-
ty word, an E-mail ID, and an E-mail password.

If you enter an E-mail ID that is already in use, you'll be asked to
enter another one. You can use any form of your name. For example,
you might use your initials, or spell out your middle name, to make
it unique.

10



You can record your E-mail information below for future reference. Do
not disclose your password, your security word, or your account informa-
tion to anyone.

Your E-mail ID

(%ar;not contain spaces or any special characters except hyphens or peri-
ods

Your E-mail password

(thisdvgord is case sensitive; that is, “PassWord” is not the same as “pass-
word”

Click Continue after you review each page. Click Finish at the last
page to complete your registration. Afterward, be sure to restart
Windows 95 when prompted so your computer is configured proper-
ly to run the software.

This is a good time to back up your account information. See page
39 for further information.

Please note: If you are disconnected during registration, select the
Double Click to Set Up Account icon, or symbol, to start over. At the
opening screen, choose the | need to create an AT&T WorldNets
Service account option.

11



Browsing the Internet

Congratulations! As a new member of the AT&T WORLDNET*™ Service,
you're ready to explore the wide world of the Internet.

After you've completed registration, you can gain access to the
Internet at any time by double-clicking the AT&T WORLDNETM
Service icon on your desktop or in the AT&T WORLDNETS™ Service
folder.

2l

B — e
WorldNet
Service
i: Connect To ﬂm
DO NOT CHANGE ATAT Woret(

your user name
or password. Dsecname: | 123456780@worldnet attnet

PBassword. SR

¥ Save password

Phone number: 5551234
Click Connect Dialing fram: home =| Dial Properties...

to begin
\@ cancel |
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After a moment, you'll see the AT&T WoRLDNET®™ Service home
page on the World Wide Web (www). The simplest way to begin

browsing the Internet is to start here, and begin clicking on hyper-
links to explore your options.

Hyperlinks are special words or graphics in a document that contain
the address of another document. By clicking on these hyperlinks,
you can explore many thousands of sites, services, and information
sources across the country and throughout the world.

\\-‘bl(}@lﬂ(‘,- [o
AT’ WorldNet™
AT HOME / AT WORK

Welcarme frorm Torn Evslin
Mew Users Click Here
Safe Surfing

Access Mumbers

Senice Announcemeants

Hyperlinks can be easily identified because your mouse
cursor changes (usually to a hand icon) when passed
over any linked word or graphic image.

13




How to get help and advice

Before you begin exploring the Internet, you might want to take a
moment to check two useful sources of information.

If you're new to the Internet, click on the New Users hyperlink for a
quick explanation of unfamiliar terms and useful advice about
exploring the Internet.

The Help menu contains detailed information that may be of use
even to more experienced users of the Internet.

If you need help with installation, registration, or use of the software,
check the Troubleshooting Guide in the AT&T WoRLDNETSM
Service folder (see page 30).

Note: You must click Disconnect to end your
connection to AT&T WorLDNETSM Service (see page 38).

% ¢ Connected to ATRT WorldNet (...

Elé-:: Cannected at 14400 bps

Ciuration:  000:01:14 ]
¢ Details»> 7
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ATA&T WorldNet Service - [AT&T WorldNet(sm): Home Page]
Eile Edit ¥iew Go Bookmarks Options Directory Mindow Help

o | = | B W | & %
Back Forward Home Reload Inages Dpen Frint Find Stop / Metzcape

Location Ihttp.,ff\wm.wurldnet.ah net/index.html
ATET WorldMet | Member Services | Searchl Directaries | ewsgroups
[

Weleome fo
ATET WorldNet”

AT HOME / AT WORK

|»

Welcome from Tom Evslin
Mew Users Click Here

Safel Rutfin
Ag hurnbers
Se Announcernents

Custormer Service

Help menu

* About AT&T W oRLDNETS" Service :
Shows software version information.

New Users Click Here « Netscape Navigator Handbook : A
H SM
New to the Internet? Click guide to AT&T WORLDNET" SERVICE
: o software.
here for a quick description of
the Internet and tips to make + Where to Get More Help : Takes you
browsing easier. directly to AT&T WORLDNET" SERVICE

Member Services for technical sup-
port and online help with account,
billing, and child safety concerns.
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Using your AT&T WorldNet™ Service
software File Edit Vi

The AT&T WORLDNET™ SeRVICE software makes
Internet browsing fast and simple. For a more
detailed description of these and other program fea-
tures, click the Help menu and select Netscape
Navigator Handbook.

To create more room for Internet pages, you can
make your document window larger by “hiding”
the Toolbar and Directory buttons if you don’t
often use them. Click the Options menu to display
a list of features you can show or hide.

It's easy to get lost in the worldwide maze of the
Internet. No matter where you are, you can always
start over by clicking Home to return to AT&T
WOoRLDNETSM Service.

TIP: While browsing Internet documents,
click your right mouse button for quick
access to many frequently used features.

=8| [http:/A

16



et Service - [AT&T WorldNet{sm): Home Page]
¢+ Go Bookmarks Options Directory Window Help

o wmm|lo|lal »

Hame Fiele Inages Qpen Prink Find Stop Metscape

wanans o dnet att het/indes htrml

et rMember Bervices | Search | Directories | MNewsgroups

\ \ [

The Bookmarks menu For quick access to AT&T
is a directory you can Customer Service, click
customize to find your Help, then select Where to
favorite places quickly Get More Help.

(see page 18).

Click the Directories
button for a list of
Internet resource,
personal, and business
directories.

The status line shows the Internet

address (URL) of any hyperlink as Click here to check for new
you pass your mouse cursor over a E-mail, or to send a mes-
page displayed in your document sage to someone else (see
window. page 20).

rw.worldnet.att.net/ =y
17



Bookmarks make browsing easy

Bookmarks allow you to keep track of your favorite Internet sites, so
you can return to them whenever you want. Click on the Bookmarks
menu to see a list of sample sites. You can go directly to a site by

clicking on any item in the list.

As you browse the Internet, you can add sites to the list by clicking
Bookmarks | Add Bookmark (or just press Ctrl+A on your keyboard).

= ATAT WorldNet Service - [ATAT WorldNet(sm): Home Page]

File Edit Mew Go Dptions  Directory  Window  Help
Go o ‘Eﬁ Add Bookmark: Ctrl+D O
Back | Forward | Home Goto Bookmarks. Cirl+B Srop Meretmne
Location lm Directoties L LI
Flug-ins 4
ATET WorldMet _ Ecology and Enviranment N EI MNewsgraups |
. Computing L4 -
Trawvel L4
Family 3
‘Weather L4 (")
Career L ]
Rec nand S 3 ESPMNET SpornsZone
The Newsstand \ L4 Golfeb
At and Literature L4
Government »  Thelnternet Movie De\kase Tou
Food L4 The MNational Park Service
Leisure 3 The Consummate Skiing List
Shopping 3
Companies 4 | ||

TUSIOTEr Semvte
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Click Bookmarks | View Bookmarks (or press Ctrl+B) to open a new
window showing all bookmarks. You can use the File, Edit, and Item
menus to customize your list, by adding or moving categories or spe-

cific sites.

Double-click any cate-

gory to show or hide
its contents.

§] Bookmarks - Bookmark_htm

File Edit ltem

Ea Recreation and Spons

L ESPMNET Sponssone

Golfveh

Sportsling USA

The Internet Mowvie Dar:

; The MNational Park Sera.
L @ The Consummate Skim

Ea The Mewsstand

| = On-line Magazines

- WS Maney and Invest

- B Welcome to 7D Met

[ Security AFL Quote Ser

e L Yahoo-Newspape:s

Eﬂ Artand Literature

b ]? The Internet Pullic Libre

¥ The'World-wWide Weh
- B The Fine Arts Museums
B The wWhitney Museum
The Metropolitan Musey

LB Daric Damac bAncao Mol
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Sending and receiving E-mail

On AT&T WorLDNET™ Service, you can exchange E-mail with
anyone in the world who has access to the Internet. To send or
receive mail, select Window | AT&T WorldNets¥ Service Mail (or
click the E-mail icon at the lower right edge of your screen).

To receive messages, you should let others know your E-mail address.
Your address is your E-mail ID followed by

@worldnet.att.net. For example, the address of a person using the ID
“pjones” would be: pjones@worldnet.att.net.

- TIP: To check quickly for new mail, click on
=i % the envelope icon, at the lower right edge of
your screen.

W Welcama frorm Torn Evslin
Mew Users Click Here
Siafe Surfing

Access Numbers

Service Announcements
Press Releases
Customer Service

At Home | Whats Mew At Home | nhats Mew At ifor | At thio i

@ Copwight- 1006, ATET Comp. Al ights esened. ATET ATET.and Flobe Fesign and AT&T WorldHet-are seri
matks of ATET. The othetmaks which appear enthis Web Site may be'mare of third padies that.are fot-atfiliated Nith

ATETUATET and s affiliates do'not santral or =ndeise the sontént of Hhird party Web: Sites
-
<3| |Document Done =7 /ﬂ
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4

B4

o @ | a2
Getbeil| | Dalete | oMl | Retl | Rl [ Romm| prevoe| nec | P | s
kail Faolder |Unrea4TDtaI| Sender |A|$‘7Subjecl
[ iInbox 3 [ & ATAT VR EIGOT TR
S Trash ] ~E) Bob white Urnmnoloy
1 Sent z Y G.oSmith meaw addre

Subject: New address
Date: Sat, 4 May 1996 09:54:04-0500
From: csmith@workdnet.att.net (Chris Smith)
To: pienes@workdnet. att.net (Pat Jones)

Hello, Pat. I'we just subscribed to the AT&T WorldHet Service, so ny =
address has changed. It's now cesmith@worldnet. att . net. You can enter i
into your address book by clicking on the message menu.

Chris
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Using Netnews

Netnews works like a global bulletin board, where people all over the
world can post, read, and respond to messages organized by topic, or
newsgroup.

Click the Newsgroups button to begin using Netnews. The News
window will display a sample list of newsgroups. You can view more
by clicking Options | Show All Newsgroups. To subscribe to any news-
group, click the check box next to the group name.

Click on any newsgroup to see the list of messages it contains. You can
reply to any message by clicking the Message menu, or submit a mes-
sage of your own by clicking the File menu.

Click here to open your Newsgroups window

= ATRT WorldNet Service - [AT&T WorldNet{sm): Home Page]
Eile Edit ¥iew Go Bookmarks Options Directory Mindo Help

oy

Forward

Relood | lmages

= B % & \g|
Frint Find = Metscape

o
Back Home: =
Location Ihttp.,ff\wm.wurldnet.ah net{index.html ;I

ATET WorldMet | Member Services |Search| Directaries | MNewsgroups I
|

\\-‘fQ}C@'mE}- fo

rw e wwrY % ww T s
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| o (| ¥ of
Tio: Wil F\eMaII FHENEWS HEBoth

To flesws Foreard | Frevicis] Mest Thread | Group
MNews Server @Unreat{TDtal | Sender
B3 netnews worldn.. ault news host) EI--

& ‘news.annou.. e newusers 33 34

=) news.newus...questions 6985 6985

“BE] news.answers 1832 1833

=l

Subject: A Guide to Social Newsgroups and Mailin
Date: Thu, 28 har 1996 09:01:05 GRMT

L N ] U N i
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Access telephone numbers

During registration, the AT& T WoRLDNET™ ServICE software sug-
gests an access telephone number for you. If you prefer to use a
different one, you can use any number listed here.

If you have selected one of your local phone company’s calling plans,
you may want to ask them whether the access number you select is
covered by the plan.

If none of the numbers listed here are acceptable, ask your local tele-
phone company about optional calling plans in your area that may
allow you to use one of the numbers listed here at a reduced rate.

Otherwise, you can use the number 1 800 543-3279 for an additional
charge of $4.50 per hour (about 8 cents per minute). This number can be
convenient to use when you're away from home.

To change your access telephone number, right-click your AT&T
WOoRLDNET®™ SERVICE connection in the Dial-Up Networking folder.
Select Properties, enter the number where indicated, then click OK.

Questions? Call 1 800 400-1447

We're here to help you, 24 hours a day, 7 days a week.

ATeT

-
Pr—
fr—Y
—
~—
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Alabama
Birmingham ... 327-6520
Huntsville .... 518-2140

441-9370

223-5140
Arizona
Phoenix........cccocu.. 602 340-9248
TuCcsSON ... 520 770-9006
Arkansas
Little Rock.............. 501 372-0104
California

Long Beach ...
Los Angeles ...
Modesto ...
Ontario .
oxnard .......ccoceenee.
Palm Springs .
Redwood City........
Sacramento ...
Salinas .
San Bernardino ....
San Diego
San Francisco.
San Jose...
Santa Ana

633-3630
497-7822
767-5950
581-0270
429-7493
955-5409
491-3150
983-8604
487-7344
320-9426
562-2400
498-3020
771-1150
884-7604
220-6920
296-1275
494-0910
444-9327
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Santa Barbara........ 805 564-1115
Van Nuys .............. 818 986-0462
Stockton ................ 209 939-3089
Colorado
Colorado Springs ..719 444-0216
Denver ... 303 572-0522
Connecticut
Bridgeport 203 696-3940
Danbury . ..203 207-5430
Hartford... ..860 244-8200
New Haven. ..203 777-1942
New London..........860 442-9324
Stamford................ 203 975-2908
Florida
Daytona Beach...... 257-5990
Fort Myers.............. 277-7171
Fort Lauderdale .... 316-1500
Gainesville ... 337-6885
Jacksonville 798-3300
.................... 375-7600
690-3059
Orlando... . 245-7802
Panama City .......... 913-3400
Pensacola 470-0800
Sarasota . 365-5700
Tallahassee .... 224-2223
Tampa......cccoeveenenne 621-1178
West Palm Beach ..407 803-4672
Winter Haven ........ 941 295-9500



Access telephone numbers (continued)

Georgia lowa
Albany... 430-8900 Cedar Rapids ........ 319 362-1910
Atlanta... 221-3620 Davenport.............. 319 322-9333
Augusta.................. 821-8700 Des Moines............ 515 288-2810
Columbus 321-2070
Macon......ccceeeeeeene 765-4200 Kansas
Savannah 651-6000  ropeka ............ 913 235-1491
.. Wichita ......cccceevene 316 264-1712
Hawaii
Honolulu................. 808 536-8495 Kentucky
Lexington 252-3031
Idaho Louisville 562-0830
BOISe....ccviiiiiiine 208 344-1009
Louisiana
llinois Baton Rouge.... 336-8400
Champaign............. 217 352-0679 Lafayette 289-1009
Chicago .. 441-0661 New Orleans.... 561-7860
Peoria ... 673-8611 Shreveport 675-3000
Rockford .. 966-1001
Springdfield ............ 217 525-6199 Maine
. Portland ................ 207 879-9650
Indiana
Bloomington.......... 812 334-1115 Maryland
Evansville ... 424-0104 :
Fort Wayne ........... 422-3476 Eﬂa'“mo.re ;gg'gzg
Indianapolis 237-0039 onrovia -
South Bend............ 239-7125
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Massachusetts Nebraska
Cambridge ............ 617 621-3400 Omaha .......ccccee.e. 402 341-6863
Lawrence .............. 508 557-0299
Springfield ............ 413 263-6630 Nevada
Worcester .............. 508 751-4900 Las Vegas 386-8056
L Reno 334-4400
Michigan
Detroit .........ccoovvenn 313 964-3100 New Hampshire
Grand Rapids ........ 616 776-2601
Kalamazoo ... 616 226-9408 Manchester-............ 603 627-0300
Lansing .... 484-7994 New Jerse
Saginaw .. 753-6166 y
Asbury Park .... 493-3030
Minnesota Fanwood.... 322-2288
Carteret 541-2600
Minneapolis .......... 612 339-0328 Freehold 866-0347
Rochester .............. 507 286-1047 Middletown ... 615-0112
oL Morristown ............ 292-9557
Mississippi New Brunswick 418-0357
Gulfport........cccee..e. 601 867-9078 Newark .......cccoeeeee 623-1292
Jackson ... 601 360-2000 Passaic 458-8484
Pleasantville .... 383-0315
Missouri Princeton 275-0955
Kansas City.......... 2214569 ~ Ridgewood . 251-8561
Springfield . 866-1239 Rochelle Park ........ 291-0121
St. LOUIS oo 534-6483  1TEMOM s 581-8100
Montana New Mexico
BIlliNGS oo 406 245-1399 Albuguerque-.......... 505 242-7070
Great Falls ............ 406 771-7718

27



Access telephone numbers (continued)

New York Oklahoma
447-0459 Oklahoma City ...... 405 270-0039
724-9070 Tulsa ..ooovevieiieine 918 582-0129
853-0820
528-2420 Oregon
249-2948
E 686-0449
Poughkeepsie........914 452-0038 g oon 2174
Rochester . 454-1030 Salem 362-0785
Syracuse 448-4575
White Plains ... 397-2300 .
Pennsylvania
North Carolina Erie 454-6182
Asheville 232-5200 Harrisburg... 236-5884
Charlotte ... 376-2060 Philadelphia 772-1560
Fayetteville .. 678-2036 Pittsburgh ... 391-6163
Greensboro 412-5880 Scranton 348-4060
Raleigh 508-3000 YOrK ..oooveeieeeieinee. 843-9008
Wilmington 350-8800
North Dakota Puerto Rico
o 701 232-4658 San Juan................ 787 725-9622
Ohio Rhode Island
Akron 374-1400 Providence ............ 401 453-9360
Canton .. 588-2273
Cincinnati 665-9909 South Carolina
Cleveland 622-7566
Columbus . 221-8831 Charlest'on e 803 720-4240
Dayton 449-1444 Columl?la ..803 988-7420
Mansfield 522-2308 Greenville ... ..864 282-0400
Toledo 243-0147 Myrtle Beach.......... 803 626-3834

Youngstown ...

744-7981
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South Dakota Vermont
Sioux Falls ............ 605 336-3437 Burlington .............. 802 865-2750
Tennessee Virginia
Chattanooga.......... 757-8800 Arlington 685-8700
Johnson City.. 282-5304 Lynchburg.. 847-0262
Knoxville ................ 521-0100 Norfolk 626-3835
Memphis 543-5400 Richmond 771-5440
Nashville 401-7570 Roanoke 342-9185
Texas Washington
Abilene . 676-0273 Kennewick ... 735-4400
Austin ... 708-0200 709-2460
Beaumont.............. 409 838-1988 382-0108
Brownsville ............ 210 546-0121 Spokane 456-0421
Corpus Christi........ 512 883-0280 Tacoma ......cccceeuene 272-3982
Dallas ... 826-4651
El Paso . 577-0400 West Virginia
Fort Worth 338-1047
Houston 759-6839 Charleston ............ 304 340-8066
Longview 753-6390 Wisconsin
Lubbock .. 749-0397
Midland..... 683-5510 Appleton ............... 414 831-4920
San Angelo........... 915 653-0126 Madison 282-7944
San Antonio .......... 210 225-0742 Milwaukee 223-5112
Waco......cccocvvvenenenn. 817 752-4994
Wyoming
Utah Cheyenne............... 307 632-0673
Salt Lake................ 801 322-5758
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If you need more help

Click the Troubleshooting Guide icon in the AT&T
WorLDNET®™ Service folder for helpful tips and
Troubleshooting  advice about installation, registration, and use of the
Guide software. In the Troubleshooting Guide, you'll find
complete answers to questions and problems like the ones described
in this section.

Configuring Windows 95 to work with
your modem

1 Click Start on the Windows 95 taskbar.
2 Select Settings, then click Control Panel.
3 Double-click Modems.
4

If your modem is listed under the “General” tab, it has been con-
figured to work properly. If not, click Add, then follow the
instructions on screen.

Questions? Call 1 800 400-1447

We're here to help you, 24 hours a day, 7 days a week.

30



& ATRT WorldNet Service [_ o] ]
Filz=  Edit Bookmark Options Help
Qumemsl Index | Find | Back | Erint | << | > |

TABLE OF CONTENTS

L Installation and Registration: an overview of the installation and
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If you need more help (continued)

Installing Windows 95 Dial-Up Networking

You'll need your Windows 95 cp-rom or disks to install Dial-Up
Networking.

1

2
3
4
5

(2}

Click Start on the Windows 95 taskbar.
Select Settings, then click Control Panel.
Double-click Add/Remove Programs.
Click the Windows Setup tab.

Select Communications (but do not click the check box next to
it). Click the Details button.

Select the Dial-Up Networking check box, then click OK.

On the Windows Setup tab, click OK. When prompted, insert
your Windows 95 cp-rom (or disks) to begin software installa-
tion.

Note: Do not restart Windows 95 until you have added the TCP/IP
protocol (see next page).
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After Dial-Up Networking is installed, follow these steps to add the
TCP/IP protocol:

1
2
3
4
5
6

~

Click Start on the Windows 95 taskbar.
Select Settings, then click Control Panel.
Double-click Network.

On the Configuration tab, click Add.
Double-click Protocol.

Select Microsoft from the “Manufacturers” column. Select
TCP/IP from the “Network Protocols” column.

Click OK. Windows 95 will then install the appropriate software.

When prompted, restart Windows 95. You will be prompted to
enter a user name and password. Do not click Cancel. Enter your
name and an optional password. If you choose not to enter a
password, you will be logged in to Windows 95 automatically
whenever your computer is restarted. Click OK to continue.
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If you need more help (continued)

Logging onto Windows 95
When you set up your account, you may see this message:

“When using the Internet, Windows 95 requires users to log on to
their computers. If you have a logon, please restart the computer and
enter it.”

This message means that you are not logged on to Windows 95. To log
on, follow these steps:

1 Click Start on the Windows 95 taskbar.
2 Select Shut Down...

3 Select the option “Close all programs and log on as a different
user.” (If this option does not appear, consult the How-to section
of the Troubleshooting Guide, under the heading “How to install
the client for Microsoft Networks.”)

4 Click the Yes button.

Windows 95 will restart, and you will be prompted to enter a user
name and password. Do not click Cancel. Enter your name and an
optional password. If you choose not to enter a password, you will be
logged in to Windows 95 automatically whenever your computer is
restarted. Click OK to continue.
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Netscape Navigator 2.0 software is already installed

Please note that special care must be taken if you want to maintain
both AT&T WoRLDNET™ SErvICE software and another copy of
Netscape Navigator 2.0 on the same computer.

Do not install AT&T WoRLDNET®™ ServiICE software in the same
folder as your Netscape Navigator software. The default folder select-
ed during Setup is recommended (c:\Program Files\WorldNet).

After installation, click the Troubleshooting Guide icon in the AT&T
WOoRLDNET™ ServiCE Services folder to learn which Windows 95
settings are shared between AT& T WORLDNET™ ServiICE and
Netscape Navigator 2.0 software, and to learn how to maintain them.
This information can be found in the Special Cases section of the
guide, under the heading “When You Have More Than One
Installation of Netscape Navigator Software 2.0.”
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If you need more help (continued)

Upgrading from an earlier version of AT&T WoRLDNETM
SERVICE software

If you've installed an earlier version of AT&T WORLDNET™ SERVICE
software, follow these steps to upgrade your software quickly:

1 Double-click the Double Click to Set Up Account icon in your
AT&T WorldNet Service folder.

2 Click Next on the opening screen.

3 At the “Updating Your Dialing Information” screen, select Yes,
then click Next.

4 At the “Modem Information” screen, make sure that the correct
modem is displayed, then click Next. If no modem (or the wrong
modem) is displayed, select Cancel. If you are asked to restart
Windows, select Restart Later. Follow the instructions on page
30 to configure Windows 95 for your modem, then return to
step 1 on this page.

5 At the “Exploring the Internet” screen, click Finish to complete
your software upgrade.

When prompted, restart Windows 95 to configure your system prop-
erly. Keep your E-mail password handy, since you will have to re-
enter it the first time you use E-mail services with your new software.
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Dial-Up Networking has lost my password

Follow these steps if you see the error message: “Unable to connect to remote
computer. Check your password and then try again.”

1

Double-click the Shortcut to AT&T WorldNet*™ Service icon to
display your user hame (similar to 123456789@worldnet.att.net)
and password (***************).

Open the AT&T WorldNet Service folder and double-click on
the Troubleshooting Guide icon.

Click Table of Contents, then click How To.

Click Backup your AT&T WorldNet™ Service account informa-
tion and follow the instructions on screen. Select Account
Summary Only.

Check the Connect To window to make sure the “User Name” field
contains the same information as the “Network login nhame” infor-
mation in your account summary.

Copy the contents of the “Network password” field (in your
account summary) to the password field of the Connect To win-
dow.

Make sure there is a check mark in the “Save Password” box.

Click Connect for access to AT&T WoRLDNET®™ Service. (Note
that Windows 95 will not save your password until you have used
it to log on to the service.)
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If you need more help (continued)

Telephone line does not disconnect

automatically after exiting from the AT&T WorLbNET="
SeRVICE software

Closing the AT&T WOoRLDNET® Service software does not automat-
ically disconnect you from the Internet.

To close the connection, click Connected to AT&T WorldNet™™ Service
on your Windows 95 taskbar, which opens a connection status win-
dow. Click Disconnect to close the connection and hang up your
phone line.

If your connection is idle for 20 minutes, the software will ask you if
you want to disconnect from the Internet. To change this time inter-
val:

1 Click your right mouse button on the AT&T WorldNet*™ Service
icon (on the Windows 95 desktop).

2 Select Properties.

3 To turn the automatic disconnect feature on or off, click the Auto
Disconnect check box.

4 \When the automatic disconnect feature is on, enter the time
interval you prefer. The software will disconnect from the
Internet after the period of inactivity you select.
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Backing up or moving your account
information to another PC

Complete instructions on how to back up your account
information, or move it to another PC, can be found in the
Troubleshooting Guide. To review this information:

1 Double-click the Troubleshooting Guide icon in your AT&T
WorldNetSM Service folder.

2 Click Table of Contents.
3 Click How-to.

4 Click Back up your AT&T WorldNetSM Service account infor-
mation.

Note: An AT&T WoRrLDNETSM Service account may be used on
more than one PC only under specific conditions. Click Terms and
Conditions on the AT& T WorRLDNETSM Service home page to see a
copy of your service agreement.

Questions? Call 1 800 400-1447

We're here to help you, 24 hours a day, 7 days a week.
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Windows 3.x Users:
Before you begin

Typically, you will need 30 minutes to install, register and log on to
your AT&T WorldNet™ Service account. Should you require assis-

tance at any point in the process, call AT&T WorldNet*™ Service
Customer Care at 1 800 400-1447.

Installation tips

When installing the software, please follow the instructions for set-
up. At the end of installation, your computer will restart. Don't forget
to click on “RESTART WINDOWS" because you will not be able to reg-
ister until you have done this.

Once you've installed the CD-ROM, the software will “call” AT&T
to register you as a new customer. If you experience a modem problem,
try selecting Hayes Compatible. If this does not work, call customer care
at 1 800 400-1447.

During the registration process you will be asked to:

« Choose a special “security code” that you will use to verify who you
are when you call customer care.

« Tell us whether you are an AT&T Long Distance Service customer
so that you can receive the 5 free hours a month usage plan.

« Choose an e-mail address identification that will be your “name”
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on the Net.

« Choose an e-mail password that you will use to create your AT&T
WorldNet* Service account.

System Requirements
To run AT&T WorldNet* Service you need:
« An IBM-compatible personal computer

« 80386X processor (or better) Microsoft® Windows® 3.1X or
Windows 95

« 8MB RAM and 11MB of free hard disk space

* 14.4 bps (or faster) modem and a phone line not connected to a
Local Area Network (LAN)

Getting Started
To Install AT&T WorldNets Service, simply:

 Turn on your computer and modem, start Windows, and close all
other applications, Microsoft Office™.

« Insert Disk 1 into your floppy disk drive (A or B)
« From the Program Manager, choose File/Run
 Type A:\setup (or B:\setup)
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e Choose OK

« Follow the instructions on your screen to register for AT&T

WorldNet Service. (During registration, you will be prompted to
enter a valid MasterCard, Visa, or American Express Card number.

Please read through the AT&T WorldNet*™ Service terms and con-
ditions before you register.

Be sure to check for error messages. In order for your account infor-
mation to be accepted, you must enter the information fully and cor-
rectly.

If you make a mistake and exit the registration process prematurely,
all you need to do is click on “Create New Account.” Do not click
on “Edit Existing Account.”

Complete all three stages of registration. A check mark will be dis-
played next to each stage when you have successfully completed it.

When choosing your AT&T WorldNet™ Service access telephone
number, you will be given several options. Please choose the one
nearest to you.

© 1996 AT&T All Rights Reserved. AT&T WorldNetsv Service is a service mark of AT&T

corp. Netscape Navigator logos, Netscape Navigator, and Netscape are trademarks of Netscape
Communications Corporation.
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